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The purpose of this documentation is to provide users with a detailed guide on how 

to effectively use the Iris automated coding software, which is designed to determine 

the underlying cause of death based on the updated WHO ICD-10 coding guidelines. 

This software facilitates the input and analysis of Medical Certification of Cause of 

Death (MCCD) forms, ensuring accurate identification of the cause of death. It is 

essential for doctors to complete the MCCD forms according to the prescribed rules 

to ensure consistency and accuracy in reporting.  

  Iris Software 

• Iris is an automatic system for coding multiple causes of death and for the 

selection of the underlying cause of death. 

•    Iris software can process death records either in batches or interactively. 

• The aim was to develop a common mortality coding system that could be used for 

coding death certificates in any language and using the latest version of International 

Classification of Diseases (ICD) 

 About Iris Institute 

• The Iris Institute emerged from an international cooperation for the deployment, 

maintenance and development of the Iris software, an electronic system for 

automated coding of causes of death. 

 Aim of Iris 

The aim of Iris is twofold: 

• To provide a system in which the language-dependent aspects are separated from 

the software itself. Moreover, the language-dependent parts are stored in database 

tables and can easily be modified. 

• To improve international comparability. Iris is based on the international death 

certificate form provided by WHO (World Health Organization) of ICD-10 and the 

causes of death are coded according to the ICD-10 coding rules. Updates to ICD-10 

are included according to the WHO timelines. 

 Iris Characteristics 

• The Iris software uses the Multicausal and Unicausal Selection Engine (MUSE). 

• MUSE (multicausal and unicausal selection engine) is a new software tool which 

supports the implementation of uniform coding practices and reduces daily workload 

of coding staff. 

• MUSE operates based on internationally agreed decision tables which are based on 

the most recent version of ICD-10. 

• The Software is free of charge but not open source. 

• The Iris software uses ICD-10-WHO codes and titles. Duplication and distribution of 

the ICD-10-WHO content are prohibited. All rights to the ICD-10-WHO belong to the 

WHO, and its use requires an agreement with the WHO. 

 

Introduction 



 International decision tables 

• Iris/MUSE uses international agreed decision tables (DT). 

• The decision tables have been maintained by the Iris Institute according to the WHO 

official updates of the ICD-10. 

• Updates were done after discussion by the Mortality Reference Group (MRG) 

[including updates by the Table Group (TG)] and decision by the Update and Revision 

Committee (URC). 

• The current decision tables derive from those developed by the NCHS (National 

Centre for Health Statistics) for the selection of the underlying cause of death used 

by ACME (Automated Classification of Medical Entities). 

 Iris Institute Partners 

• Iris Institute Partners: DIMDI (German Institute of Medical Documentation and 

• Information) and BfArM (Federal Institute for Drugs and Medical Devices ) have been 

merged, the secretariat is hosted by BfArM. 

• Canada, France, Germany, Hungary, Italy, Netherlands, USA, England and Wales 

collaborate as the Core Group in the development of Iris. 

• Iris is maintained by the Iris Core Group in the realm of the Iris Institute 

 Iris User Reference Manual 

• Iris user reference manuals are available for different versions of Iris, providing guides 

on how to use the software. 

• Before installing and using the software, the user should read the manual carefully. 

• Iris reference manual for Iris version 5 (based on ICD-10) are available on Iris Institute 

website. 

Iris User Reference Manual 

 Iris Newsletter 

• "Iris News" is free of costs and informs you about the latest news concerning Iris. 

 Iris news subscribe and unsubscribe 
 
 Iris users 

• Countries that have acquired some knowledge in the use of Iris can help other 

countries to start their implementation process as well. Therefore, we ask the users 

of Iris to share some information on their status of implementation. 

 Iris training 

• You can choose prerequisites trainings for Iris implementation, such as: 

o Use of the WHO standard MCCD format 

o Coders trained on manual ICD and decision table-based mortality coding  

o Availability of IT support 

o For the text-entry mode, the availability of a dictionary 

 

 

 

 

https://www.bfarm.de/EN/Code-systems/Collaboration-and-projects/Iris-Institute/Iris-downloads/_node.html
https://www.bfarm.de/EN/Code-systems/Collaboration-and-projects/Iris-Institute/Iris-news/Subscription/_node.html


 

• We can coordinate a training program for you. You might choose for example: 

o Advanced Iris features training for coders, IT-people and other staff 

o Standardization with Regular Expression for coders, IT-people and other staff 

o Workshops for coders, IT-people and other staff. 

 

 Iris meeting 

• Each year the Iris Institute organizes an Iris User Group meeting. At the meeting the 

participants report about their experience and plans with Iris. 

• The participants can share their experiences at the meeting and they can also gain 

new insights into processes in other countries. 

Support 

• Iris is maintained by the Iris Core Group in the realm of the Iris Institute. The 

maintenance supported by the member countries of the Iris Core Group can only be 

limited and restricted to the basic updates necessary and will not cover the 

implementation in other countries. 

• In order to give users the opportunity to contribute to the maintenance and update of 

the Iris system and thereby guarantee the long term availability of the Iris software a 

support model was put in place. Contributing to the Iris development by agreeing to 

support Iris will give you two advantages: 

o Support Iris: You will help to guarantee availability and up-to-date 
software that is adapted to ICD updates and software evolvements. 

o Receive support: Additional benefits for your country will help 
you to implement and use Iris 

• All financial support received by the Iris Institute will be used to maintain, update and 

further evolve the Iris software. 

 Iris versions 

• The download area of the Iris Institute contains the released versions of the Iris 

software, Iris manuals, decision tables updates and translated interfaces. 

Iris Versions 

 Download Iris Software 

• The download and the use of the Iris software is free, there are no licenses. Except: 

You must accept the download condition at the time of the download. 

Download Iris Software 

https://www.bfarm.de/EN/Code-systems/Collaboration-and-projects/Iris-Institute/Iris-downloads/_node.html
https://www.bfarm.de/EN/Code-systems/Collaboration-and-projects/Iris-Institute/Iris-downloads/_node.html


 
 

 Iris Software use System  

You can use Iris under these systems: 

o Microsoft Windows Vista, Windows 7, Windows 8, Windows 8.1 and Windows 10 

o Microsoft .Net Framework (since 4.5.2) 

o Microsoft Access 2003 or later, if no other database manager is available (it is not 

possible to use "Apache Open Office" database) 

o or a robust relational database server like Oracle, MSSQL, PostgreSQL or MySQL 

directly 

o or any through OLEDB, parameters described on Connection Strings Reference 

Iris is independent of your browser and you can use Iris in a server environment for 

multiple users. 

Before you first install Iris, ‘.Net Framework’ should be already installed. 

 Installation of Iris with Windows installer  

Unzip the installation files and place them in a separate folder. Open the installation folder 

and click on the “IrisInstallation.msi” program. Then follow the instructions of the Iris setup 

wizard. 
 

Installation 

https://www.connectionstrings.com/


During the installation, you may change the default installation folder and the rights to use 

Iris on the computer. By default, the installation wizard places Iris in the “C:\Program Files 

(x86)” folder 
 

When you have installed a new version of Iris and that an older version was used, Iris will 

ask at first whether you want to keep your settings or not: 
 

During the first start Iris will show the window below: MUSE window starts first time 

(content of screen could be different for each version) 
 



Then Iris will ask you which specification table you want to use. The last one contains the 

latest decision tables and multicausal tables. Please select a spec file and continue by 

clicking on “Load selected specification”. 
 

After the selection Iris will load the specification files: During initialization process the 

specification files are read by Iris and user is informed about the processed entries 
 



 Iris User Interface  

Iris User Interface opened after the load specification file. The main window has several 

groups of items. 
 

 

 

2. Individual data 
 
 

3. Medical data 
 
 
 
 
 

4. Manner of death 
 

 

 

 

 

 

 

 

1. Menu & tool bar 

o The upper part of the window includes a menu and a toolbar. The toolbar 

contains menu items that are frequently used, and you can access them with 

a single click 

o Through the File menu you can open and close lots, and exit Iris. You can 

also launch batch processing and display scanned images of the death 

certificates. 

o The Tools menu contains functions for browsing or editing the dictionary and 

the standardisation tables. Through the Tools menu you also have access to 

the Options feature, which allows you to define the default features of Iris. 

o The toolbar under the menus gives you quick access to the most frequently 
used items of the menu. 

 
2. Individual data block 

o Includes by default read only text boxes that display important background 
data (demographic data). 

o Text boxes with grey background are read only zones and cannot be 
modified. 

1. Menu & tool bar 

5. Coding block 

6. External cause 

7. Recent surgery 

8. Perinatal death 

9. Maternal death 

10. Comments 11. To-do list 12. Free text 



3. Medical Data block 

o By default, Iris allows you to enter and update only the medical data. 
o Maximum length of medical terms : Number of characters in medical text 

fields of Part 1 and Part 2 is defaulted to 500, but can be set between 50 and 

500. 

 
4. Manner of Death 

o The “Manner of Death” block on the left under the Medical part group 

specifies if the death due to a disease or condition, an accident, a suicide, 

a homicide, of undetermined intent, etc. If the Manner of Death (MoD) is 

unknown, there are alternatives for "Pending investigation" or "Not filled in". 

o Generally, the Manner of Death information should be taken from the death 

certificates when the work lot is prepared, but it can be changed manually. 

 

5. Coding block 

o The coding block are shown, the ICD-10-WHO codes Iris used to select the 

underlying cause of death. These codes also form the basis of the multiple 

cause output from the Iris system. 

o Iris also shows the status of the record after the selection procedure. If Iris, 

for some reason, could not select an underlying cause, or if the selected 

underlying cause is tentative and needs verification, the word “Reject” 

appears below the underlying cause box. 

 
6. External cause block 

o For deaths due to injuries or poisoning, the External cause block displays the 

date an injury occurred, and codes for the place of occurrence and the 

activity at the time of the injury. 

o  A larger box can be used to display free text about how the external cause 
or poisoning occurred. 

 
7. Recent surgery 

o The Recent surgery block shows whether a surgery has been performed 
within the last 4 weeks and, if so, the date of surgery and the reason why. 

 
8. Perinatal death block 

o Shows additional information on perinatal deaths (completed weeks of 
pregnancy; birthweight; age of mother; complication of the mother who 

affected fetus or newborn; tick boxes for multiple pregnancy and stillbirth). 

 
9. Maternal death block 

o Shows information about pregnancy and complication with pregnancy. The 
drop boxes are available only for female decedents. 

 
10. Comments 

o Areas can be used as desired by the coder. In the Comment text box the 

coder may write a short comment on the current death record (field type 

“Memo” with more than 255 characters). 



11. To do list 

o The error message is displayed in the To-Do list. 

 
12. Free text 

o Field can be used to store or forward larger chunks of text, for example 

internet citations concerning a specific cause of death. It can also be used to 

display additional information reported by the physician on the death 

certificate. 

 Translating the Iris interface  

• Iris labels (name of menus, items in menus, name of tools, etc.) and Iris 

messages can be translated into any language. 

• The translation file must be Unicode (UTF-8) encoded, otherwise characters 

that are not used in English (such as é, ö, Š) might disappear or get replaced 

by other characters on the screen. 

• Note that space for text is rather restricted in some parts of the Iris screen, 

and that translations must fit into the space available. 

• They are properties files for the interface in Czech, English, French, 

Portuguese and Spanish language (translated by users) available at the Iris 

website. 

• You can use the Language file field to state the location of a file with 

translations of all Iris labels. The original file, containing English texts, is 

called ‘UserInterfaceEnglishVx.x-Y20xxSx.properties’ and is included when 

you install Iris. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

  Iris Databases  

 
Iris uses two different databases: 

• The "Certificates" database contains death certificate records (Lots). 

• The "Iris Tables" database contains all the tables needed to analyse cause-of - 

death expressions. 

At the end of the installation, by default databases are available in the installation 

            folder. (C:\Program Files (x86)) 

You can move these databases to another location on your computer, or you can 

migrate them to a database server on your network. 

 
 

Iris database contain tables: 
 

 

 

 

 
 
 

Microsoft Access is the Default Database deployed with Iris setup. 
 
 
 
 
 

 

 

Databases 

Iris Database 

Certificate DB Table Database 

Ident MedCod 
Table Table 

Meta Tables Language Dependent Files 

Icd 
Substitution 

ValidIcd NonConsistent 
Codes IcdCodes 

Dictionary 
Time 

Intervals 
Separators 

Standardis  Standardis  Standardis 
ation2 ation1 ation0 



1) The "Certificates" database contains two tables: an "Ident" table and a "MedCod" table. 

1. The "Ident “(Identification) table contains all the individual data except 

the causes of death 

2. The "MedCod “(Medical causes of death) table contains the causes of 

death. 

 
2) There are two types of tables in the “Iris Tables” database: 

1. Meta-tables containing technical data, such as lists of valid codes or code 

translations (‘ValidIcdCodes’ and ‘IcdSubstitution’ table). These tables are 

necessary for a correct functioning of Iris and you should NOT change or 

delete them. Exception: you must adapt the ‘NonConsistentIcdCodes’ tables 

to the requirements of your country. 

• Iris uses the ‘NonConsistentIcdCodes’ table to check the causes of 

death against the individual’s sex and age, and whether the assigned 

underlying cause code is valid as underlying cause. Although the 

international version of Iris contains a ‘NonConsistentIcdCodes’ table 

with basic checks, it might be necessary to modify the table according 

to the local and regional health situation. 

• The ‘ValidIcdCodes’ table contains all valid ICD-10 codes and label 

names. 

• Since Version 5 the ‘IcdSubstitution’ table contains only a list of 

created codes. 

2. Language-dependent files used for standardizing and coding expressions 

from the death certificates.This concerns the Dictionary, Standardisation0, 

Standardisation1, Standardisation2, Separators and ‘TimeIntervals’ table. 

• Dictionary table: If you want to build your own dictionary, copy the 

dictionary which is available in the Iris installation file to your own “Iris 

Tables” database and then delete all records. Then enter text 

expressions in your own language and assign ICD-10-WHO codes to 

them. The dictionary tool checks that the ICD-10-WHO codes you 

enter are valid and also ensures that other variables in the dictionary 

are set correctly. 

o Standardization tables: Iris employs “rules” to standardize the text of 

causes of death. These rules are written by the user and are depending 

on the language with which causes of death are declared (Swedish, 

German, French …). A rule is made up of two filters. The first filter 

(FilterIn) identifies the “context”. The content of the second filter 

(FilterOut) replaces the context when it is recognised. ‘FilterIn’ and 

‘FilterOut’ syntax is based on a language called “Regular Expressions” 

(RegEx). standardisation, which very much reduces the size of the 

dictionary. 
 
 
 
 
 
 
 
 
 
 



 

 

 Lot Preparation  

• Before coding with Iris, you must prepare work lots containing death certificates. 

• The work lots are stored in the “Iris Certificates” database. 

• By default, it is a Microsoft Access database located in the Iris folder. 

• The default location can be changed in the Options. The Certificates database may 

be located anywhere on your computer or on a network. 

• A work lot consists of two tables: an "Ident" table and a "MedCod" table: 

o The "Ident" table contains demographic Data (Mentioned on MCCD Death 
Certificate). 

o The "MedCod" table contains the medical causes of death. 

 

Steps to create lot: 

1. Decide on a name for the work lot (e.g. "Lot1"). This name will be used to open the 

work lot in Iris. 

2. Next, create a "Lot1Ident" table and a "Lot1MedCod" table. To do so, copy the 

tables “aaaReferenceIdent” and “aaaReferenceMedCod” included in the Certificates 

database and change their name into "Lot1Ident" and "Lot1MedCod" (or whatever 

name you have chosen). Make sure that the work lot name is followed by the 

strings "Ident" and "MedCod". 

3. The last step is to feed the "Ident" table with records. The following fields must 

contain data: CertificateKey, Sex and DateBirth, DateDeath or Age if the dates are 

not presented. 

4. It is then possible to open the work lot in Iris. Launch Iris, select Open in the "File" 

menu (or enter Ctrl + O, or just click on the Open tool). You will be prompted to 

choose one of the work lot names that now appear in the list box: 

 

 
The Iris Certificates database contains a small work lot called Test that you can 

open and use for testing. 
 

How to use Iris 



 Data Entry in Iris  

Iris can be used in two modes. 

1) Code entry mode: 

o The user enters ICD-10 codes corresponding to the conditions reported 
on the death certificates. 

o Iris then selects the underlying cause. In this mode Iris is ready for use as 
soon as it is installed. 
 

 

2) Text entry mode 

o The user enters the causes of death in free text, as they are reported on 
the death certificate. 

o You need a dictionary that translates text into ICD-10 codes. 
o The advantage of including a dictionary is that once a decision has been 

made on which ICD-10 code to use for a specific diagnostic expression, 

the expression will be coded in the same way each time it occurs on a 

death certificate. 
 

 

 Iris Options  

Through the Options you can set a wide variety of default values and parameters 

according to your own requirements. The Options window has six tabs. 

 
 



1. General Tab: In this tab, you can access the Mode menu for data entry 
functions, adjust settings for behaviour, choose separators, and specify the 
log path. 
 

2. Checks tab: You can configure options for handling rejections, as well as set 
both interactive and batch coding reject options. 

 
3. User Tab: In this section, you can adjust user settings, choose the location 

for language files and upload a certificate image. 
 

4. Certificate Database Tab: The “Certificate database” tab contains settings that 
define the type of database management system used for the “Iris Certificates” 
database. 

 

5. Table Database Tab: The “Table database” tab contains settings that define the 
type of database management system used for the “Iris Tables” database 

 

6. Coding Tab: The Coding tab contains various settings related to the coding itself. 
 

 Examples using Iris Software  

• With the NCIC Browser, you can adjust parameters such as age, sex consistency, 

and determine whether a disease is classified as rare. Additionally, you can specify 

if the disease is considered an underlying cause of death. 

Example 1: Check for Sex Consistency 

Sex: Male (1) and line 1: Malignant neoplasm of the ovary 
 

Example 2: Check for Age Consistency 

Sex: Male (1) and line 1: unspecified, Birth asphyxia 
 



Example 3: Check for rare disease 

Sex: Male(1) and line 1: Acute paralytic poliomyelitis, vaccine-associated 
 

• Edit Underlying Code 

The Edit underlying cause command (or pressing Ctrl + E) allows you to change the 

underlying cause code selected by Iris. The new underlying cause code must be a 

valid ICD-10-WHO code. The record is then flagged as "Manual", which means that 

the underlying cause has been selected manually. 
 

 
• Select Main Injury 

This tab is only provided if a chapter XX code is provided as underlying cause of 

death. 

If for some reason Iris can´t select a main injury automatically and if Options- 

Checks is set to "main injury required", then the certificate will be rejected for 

manual review. 



 
 

• Iris generates UC according to Manner death. 

Example 1: 1a Haemopneumothorax J942S272 

1b Fall W19 

If Set manner of death Accident then UC W19 with main injury S272 
 

If Set Manner of Death Suicide then UC X83 with main injury S272 
 



If set manner of death Homicide then UC Y08 with main injury S272 
 

 

 

 

 
MUSE (multicausal and unicausal selection engine) is a rule-based software 

component which processes electronic death certificates and selects the underlying and 

multiple causes of death. Data processing is done in accordance with the guidelines of 

Volume 2 of ICD-10-WHO. 

The MUSE configuration is default stored in option file ‘MuseUserOptions.xml’ located in 

subdirectory ‘MuseConfiguration’ of the user path 

(C:\Users\YourName\MuseConfiguration). 

You can check your changes (MUSE settings) on the environment variables in Iris [via 

Tools, Options, Codingtab, MUSE settings]: 
 

 MUSE specification window  

MUSE logic is defined by two specification files (.csv format) being located in the 

subdirectory ‘spec’ of the installation directory 

o The file specCodes (specVxxxxSRxx-Codes.csv) contains the valid codes 

(ICD-10-WHO codes and created codes) for the MUSE logic [there is no 

change of the ValidIcdCodes table]. 

Muse in Iris 



o The file specMuse (specVxxxxSRxx-Muse.csv.DES) contains all multiple- 

cause and underlying cause of death coding instructions used by MUSE (the 

table entries based on international decisions and should not be modified by 
users). 

 MUSE explanation window - overview  

Click the “MUSE button” (or "MUSE" in the Coding menu, or use the hotkey Ctrl + U) to 

open the MUSE explanation window. The underlying cause will recode starting from the 

displayed ICD-10 codes. 
 

After clicking the “MUSE” button (toolbar at main interface) the correspondent window is 

presented to the user. Figure below shows an example: 

The group box ‘Coding log’ is on the bottom 

block of the window “MUSE explanation”. It 

shows MUSE processing steps row by row: 

Blue lines (type=SUBST): multiple-cause 

coding instructions performed by MUSE 

algorithm 

START OF SELECTION: Starting codes used for 

unicausal selection (see also UCodes) are 

displayed. The following lines represent 

unicausal processing steps 

Grey and green lines inform users about 

unicausal processing steps according to the 

ICD-10-WHO (Volume 2, paragraph 4.2.1 and 

4.2.2). In the column type is shown the name 

of the corresponding starting point rules (SP1 

– SP8) or modification rules (M1 – M4). 

Successfully applied rules are green. 

Basic data (certificate number, age, sex 

and manner of death) are displayed in the 

first two group boxes of the upper left 



The certificate is rejected and the coder can select via the ‘Multiple choice’ feature 

the correct code 

Since MUSE 2.7 is also possible to use the ‘Multiple choice’ feature. 

 

 
 

 
 Batch Processing  

• Use Batch processing command to code an entire work lot, or a subset of it, 

automatically. 

• By default, Iris codes all records in the work lot, except those that have been coded 

manually already 

 

 
• Iris creates a log file for each batch processing. This log file will be stored in the 

folder specified in ‘Options’ – ‘General’ tab – ‘Log path’ 

• By default, the log file includes the name of the lot, the records processed, date and 

time of start and end of the processing. Example: 



 
 
 

 Statistics  

The Statistics item displays coding statistics for the current work lot. For instance, the 

following statistics: 
 

 

 

 

 

 

 



From Iris User Interface using Tools Menu -> Export all option generates report of selected 

lot.This report is generated in .xml format 

Output file look like: 

 

 Decision table browser (DTB)  

This tool is very useful for experimented coders and users. It permits to browse the 

unicausal decision tables (DT) used for the selection of the underlying cause of death. The 

following example shows all the relationships using the Anchor code I64. 
 



 
 

 Iris Software implementation pre-requirements  

• Country uses the WHO recommended format of the MCCD 

• All coders are trained in manual mortality coding 

• For the text entry version of Iris, a local language is available 

• Local IT support is available 

 Iris Software implementation in Mumbai  

➢ Mumbai is the pioneer city in India, to establish a complete- Automated-cause of 

death ICD-10 coding system. 

➢ Starting from version IRIS 5.4, over 6 years, BMC has adapted various updated 

version of the software, at par with WHO ICD-10 codes. 

➢ Currently the IRIS 5.8.1 with Specification file SpecV2021SR40 (updated coding 

rules and decision tables) is being used for the Coding and Batch Processing. 
 

 

In Mumbai there are 24 

administrative wards 

under BrihanMumbai Municipal 

Corporation (BMC). 

For the convenience of city 

administration, wards have been 

decentralized. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Need for an Automated Cause of Death Coding System in BMC  

• Prior to IRIS software implementation, the coding at BMC was done manually by 

medical officers at ward level. 

• The system was decentralised and quality of data was compromised. 

• This affected the quality of cause of death analysis and reporting. 

• To streamline and update the process and to aid policy making decisions, the 

IRIS Automated Cause of Death ICD-10 coding system was introduced in BMC. 

Iris Software Implementation 

https://memumbai.com/brihanmumbai-municipal-corporation-bmc/
https://memumbai.com/brihanmumbai-municipal-corporation-bmc/
https://memumbai.com/brihanmumbai-municipal-corporation-bmc/


 Support System  

• Data for Health Initiative, an initiative by Bloomberg Philanthropies and CDC 

Foundation collectively approached Brihanmumbai Municipal Corporation (BMC) 

to improve quality of Medical Certification of Cause of Death in Mumbai. 

• Financial and Technical Partners: CDC Foundation (United States) and Tata 

Memorial Centre (Mumbai) 

 System implementing elements  

1. BMC Departments as Data Sources: 

• MIS Cell: Supplies a soft copy of the CRS Death line list for 24 wards. 

• RBD Department: Provides physical forms for the MCCD (Medical Certificate 

of Cause of Death). 
 

2. Automated Coding Software: 

• Iris Software Version 5.8.1 with specification file SpecV2021SR40 for ICD-10 

Coding 

 
3. Implementation member 

• Medical Coders 

• IT Consultant 

• Data Entry Clerks 
 

 Coding team working steps  

Step 1 : CRS death line list collection at MIS cell (Soft Copy) 

o All wards in Mumbai (24 wards A to T) send the CRS death line list to MIS 
Cell (Kasturbha Hospital, Chinchpokli) in Excel sheet format Containing 
demographic data. (eg. Certificate key, DateOfDeath, Sex, Age, Name, 
MannerOfDeath, Address, etc.) 

o MIS Cell Collects 24 wards CRS death line list and shares it with the RBD IT 
Department through email. 

 

Step 2 : MCCD forms collection at RBD Department (Physical forms) 

o MCCD Physical Forms received at RBD Department sent by 24 wards after 
completed the month. 

o The CRS line list and MCCD forms should be synchronized and verified by 
the RBD Department clerks. 

 

Step 3 : MCCD forms coded by Medical Coder 

o Comply with all requirement as per ICD-10 guideline for coding and 
underlying cause of death. 

o Assign appropriate ICD-10 codes, finding their underlying cause of death 
using ICD-10 volumes and decision tables. 

o Contribute coding information to IRIS (automated coding system) i.e. created 
codes, connected codes, coding flags 

o Resolve cases rejected by system (e.g. external injuries, pregnancy related, 
operating procedure related) 

o Review and qualitative analysis of MCCD certificate of MCGM 

o Willing to learn and keep self-updated with latest codes 



o  Work cohesively in team setting and assist team members to achieve shared 
goals 

 

Step 4 : Database creation, maintains and Iris Software implementation by IT 

Consultant 

o Received 24 ward monthly CRS death line list in Excel Sheet format by MIS 
Cell. 

o Prepare Iris Certificate database for 24 words. IT Consultant should have to 
Create a database for every year (Currently using Microsoft Access 
Database). 
By default after installation of Iris Software Iris database folder created in 

C:\Program files. By referring default format, you can create/Update new 

database. 

o Prepare lots (Ident and MedCod table) as per Iris specifications and upload 
them into the Iris death certificate database. Create Ident tables containing 
demographic data contains (CertificateKey, DateDeath, Age, Sex, Status, 
Reject, Coding, Residence, Name, Address, PlaceOfOccurrence) using CRS 
death line list. 

o Maintain a record of lots uploaded to the Iris database to avoid duplication. 
o Medcod table contains Medical Part (line codes) mentioned on Form type 

4,4A and PM form. This data entered by data entry clerks. 
o Iris Database ready to use. 

 
Step 5 : Medical Coding data entry in Iris Software by Data Entry Operators 

o Data Entry doing in Iris Software as per instructed by IT Consultant 
recommended Iris Version and Specification file. 

o Data Entry doing in Medical Part of Iris User Interface: (Part I : Line codes 
(A,B,C,D,E), Part II, Time Intervals, Manner of Death ,Free text, Comments, 
MCCD death form type etc. 

o If MCCD forms does not exist, added the record w.r.t ward. 
o Also perform a consistency check with the Age column according to the 

requirements of Iris i.e. to convert the age in Years and Days format. 
o To perform Data Entry according to the Instruction Set provided by Team. 
o Perform Batch processing on Daily basis. 
o Data entry clerks doing entry of MCCD form type (4,4A or PM form with PM 

form number). Added details from MCCD form like certified doctor details, 
physically missing forms, duplicate records, blank forms, PI, Civil death etc. 
in columns Comments and Free text provided by Iris Software. 

 

Step 6 : Rejection Handling by Medical Coders: 

o The rejects resolved by Coders, if any. 

o If required resolved with the help of consulting doctors. 

 
Step 7 : Cause of death report preparation by IT Consultant 

o Export finalised data from the database in Excel sheet format. 
o Should be merge month wise 24 ward data to get Monthly or Yearly data. 
o Data Cleaning (to find out the missing entries, duplicates entries, other 

bugs). 



o Extract the Underline cause of Codes from Iris database and prepare various 
Analysis reports. 

o Cause of Death Report (CD4), submitted to Registrar General of India 
annually. 

o Analysis of annual cause of death data by using ANACONDA software, for 
comparative study. 

o Ward wise analysis and reporting by continuous monitoring of quality of 
MCCD data, done by the medical coders. 

o Insights about requirement for training to doctors based on ward-wise 
supervision for quality improvement. 

o Based on the instruction set used for data entry in the IRIS system, the 
quality of data can be assessed, which helps to take administrative actions 
on MCCD reporting. 

o Create a report as per requirement of RTI received by MIS cell. 
o Create a report as per requirement of higher authorities of health 

department. 
 

 

 IRIS Work Flowchart(CODE ONLY MODE): BMC Mumbai Coding Team (for 24 Wards)  
 

 



 

 Outcome of IRIS Automated ICD-10 Coding System  

o Cause of Death Report (CD4), submitted to Registrar General of India 
annually. 

o Analysis of annual cause of death data for comparative study – noted 
change in mortality pattern from communicable to non-communicable 
disease. 

o This supported in prioritizing evidence-based efforts at programmatic level. 
o Continuous monitoring of quality of MCCD data done by medical coders. 
o Insights about requirement for training to doctors based on ward-wise 

supervision for quality improvement. 
o Compulsory e-learning MCCD training for all doctors in Mumbai. 
o Improved quality in writing cause of death due to these trainings thereby 

noted reduction in non-specific causes of death. 

 Impact of IRIS Implementation  

o Improved efficiency of coding system – increased speed of coding from one 
year to 3 months. 

o Increased coding consistency and accuracy 
o International compatibility (evidence of success by implementing IRIS ICD-10 

coding system - automated coding system, which has ensured international 
comparability of MCGM ICD 10 coding. 

o Data generated can be used for auditing, research, performance studies, etc. 

o Enables regular monitoring and feedback. 
 

 
Abbreviation/Term 

 
Explanation 

.accdb Microsoft Database [since Access 2007] 

.config A configuration file used to configure the parameters 
and initial settings for some computer programs. 
They are used for user applications, server 
processes and operating system settings. 

.csv Comma-separated values [file format to store data 
(numbers and text) in plain text] 

.dat A generic data file that stores information specific to 
the application it refers to 

.DES Data Encryption Standard [symmetric-key algorithm 
for the encryption of electronic data] 

.dll Dynamic Link Library 

.exe A common filename extension denoting an 
executable file; the main execution point of a 
computer program. 

.gif Graphics Interchange Format [a graphic format for 
pictures] 

.ico An image file format for computer icons in Microsoft 
Windows. 

.jpeg Joint Photographic Experts Group [method of lossy 
compression for digital images] 

.log A log file records either events that occur in an 
operating system or other software runs, or 

Appendix: List of abbreviations  



 
   messages between different users of   communication    
software. 

.mdb Microsoft Database [since Access 2007 also .accdb] 

.msi Microsoft Installer [a software component and 
application programming interface (API) of Microsoft 
Windows used for the installation, maintenance, and 
removal of software] 

.Net An open source developer platform for building 
many different types of applications developed by 
Microsoft. 

.Net Framework A software framework developed by Microsoft 

.pdf Portable Document Format [present documents, 
including text formatting and images, in a manner 
independent of application software, hardware and 
operating systems] 

.properties A file extension for files to store the configurable 
parameters of an application. 

.tif Tagged Image File Format [file format for storing 
images] 

.xml Extensible Markup Language [defines a set of rules 
for encoding documents in a format that is both 
human-readable and machine-readable] 

.xsd XML Schema Definition [specifies how to formally 
describe the elements in an Extensible Markup 
Language (XML) document] 

.zip An archive file format that supports lossless data 
compression. 

ACME Automated Classification of Medical Entities 

ADO.NET A data access technology from Microsoft .NET 
Framework that provides communication between 
relational and non-relational systems through a 
common set of components. 

DCodes Direct codes 

DT Decision tables 

DTB Decision Table Browser 

DTE Decision Table Editor 

ICD-10 International Statistical Classification of Diseases 
and Related Health Problems, 10th revision 
(https://www.who.int/standards/classifications/classif 
ication-of-diseases) 

MC Multiple cause 

MCOD Multiple cause of death 

MCDT Multicausal decision tables 

MCodes Multiple-cause codes 
 

 
MICAR 

 
Mortality Medical Indexing, Classification, and 
Retrieval 

MMDS Mortality Medical Data System 
(https://www.cdc.gov/nchs/nvss/mmds/about_mmds 
.htm) 
 
 

http://www.who.int/standards/classifications/classif
http://www.who.int/standards/classifications/classif
http://www.cdc.gov/nchs/nvss/mmds/about_mmds
http://www.cdc.gov/nchs/nvss/mmds/about_mmds


 

MoD 

 

Manner of Death 

 

MRG 

Mortality Reference Group (improves international 
comparability of mortality data by establishing 
standardized application of the ICD). 

MS Office Microsoft Office 

MSSQL Microsoft SQL Server [a relational database 
management system developed by Microsoft] 

MUSE Multicausal and Unicausal Selection Engine 

MySQL An open-source relational database management 
system (RDBMS). 

NCHS National Center for Health Statistics 

NCIC NonConsistentIcdCodes tables 

OLE DB Object Linking and Embedding, Database [also 
written as OLEDB or OLE-DB; programming 
interface designed by Microsoft for access to 
different data sources] 

Oracle Oracle Database is a multi-model database 
management system produced and marketed by 
Oracle Corporation 

PostgreSQL An object-relational database management system 
(ORDBMS). 

MCGM Municipal Corporation of Greater Mumbai 

BMC Brihanmumbai Municipal Corporation 

CDC Foundation Centres for Disease Control and Prevention 
Foundation 

MCCD Medical Certification of Cause of Death 

CRS Civil Registration System 

RBD Registration of Births and Deaths 
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